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MSG revision history

Revision Publication date Description

A January 2010 The Ultra-slim extended life battery, part number 443157-001, has been added in
the following locations:Computer major components on page 17, Sequential part
number listing on page 26, and Battery on page 39.
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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact
the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the
AC adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Branding HP Compaq 2710p Notebook PC

Processors Intel® Core™ Duo Ultra-Low-Voltage (ULV) processors:

● U7700 1.33-GHz processor with 533-MHz Front Side Bus (FSB) and 2-MB L2 cache

● U7600 1.20-GHz processor with 533-MHz Front Side Bus (FSB) and 2-MB L2 cache

● U7500 1.06-GHz processor with 533-MHz FSB and 2-MB L2 cache

Chipsets ● Northbridge: Intel Crestline GM

● Southbridge: Intel ICH8-M enhanced

Graphics Intel Graphics Media Accelerator DX10, supports 64-bit memory bus

Panels ● 12.1” WXGA WVA (1280 × 800) LED display panel with outdoor viewing, camera, business card
reader/holder, 3 wireless local area network (WLAN) antennas, and 2 (wireless wide area network)
WWAN antennas

● 12.1” WXGA WVA (1280 × 800) LED display panel with camera, business card reader/holder, 3
WLAN antennas, and 2 WWAN antennas

● 12.1” WXGA WVA (1280 × 800) LED display panel with outdoor viewing, 3 WLAN antennas, and
2 WWAN antennas

● 12.1” WXGA WVA (1280 × 800) LED display panel with 3 WLAN antennas and 2 WWAN antennas

● Digitizer with pen support

● Sparkle-free glass

Memory ● 2 SODIMM slots, customer accessible/upgradable

● PC2-5300, 667-MHz, DDRII (the computer operates at a maximum of 533 MHz with 667-MHz
memory modules installed)

● Supports dual-channel memory

● Supported configurations:

◦ 4096-MB total system memory (2048 MB × 1)

◦ 2048-MB total system memory (2048 × 1)

◦ 2048-MB total system memory (1024 × 2)

◦ 1536-MB total system memory (1024 MB + 512 MB)

◦ 1024-MB total system memory (1024 MB × 1)
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Category Description

◦ 1024-MB total system memory (512 MB × 2)

◦ 768-MB total system memory (512 MB + 256 MB)

◦ 512-MB total system memory (512 MB × 1)

Hard drives ● Supports all 1.8-inch hard drives

● Parallel ATA

● HP 3D DriveGuard

● The following hard drives are available:

◦ 120-GB, 5400-rpm

◦ 120-GB, 4200-rpm

◦ 100-GB, 4200-rpm

◦ 80-GB, 4200-rpm

◦ 60-GB, 4200-rpm

● Supports 64-GB solid-state drive

Optical drives Optical drives supported only through the HP 3-in-1 NAS Docking Station, HP Advanced Docking
Station, HP Docking Station, and HP External USB 2.0 MultiBay II Cradle (all required software is
preinstalled on the computer)

Diskette drive ● Supports an external Universal Serial Bus (USB) diskette drive only

● Supports boot from USB device

Audio ● Azalia ADI1981HD

● Single speaker

● Integrated dual-array monoaural microphone

● Headphone and microphone jacks

Modem ● 56K, v.92, data/fax modem (MDC1.5)

● Modem cable included in Brazil, the Czech Republic, France, Greece, Hungary, Israel, Latin
America, Poland, Russia, Saudi Arabia, Slovakia, Slovenia, South Africa, Turkey, and the United
Kingdom

Ethernet ● Intel 10/100/1000 Ethernet

● Network interface card (NIC) power-down

● S4/S5 wake on LAN (on AC power only)

Wireless Integrated wireless options by way of wireless module
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Category Description

 WLAN options:

● Broadcom 802.11a/b/g/n

● Broadcom 802.11a/b/g

● Broadcom 802.11b/g

● Intel 802.11a/b/g/n with iAMT support

● Intel 802.11a/b/g with iAMT support

● Intel 802.11b/g

● Supports no-WLAN option

● Two dual-band 2.4-/5.0-GHz WLAN antennas built into display panel

 WWAN options:

● Evolution-Data Optimized (EV-DO) Rev. A WWAN module

● High-Speed Downlink Packet Access (HSDPA) WWAN module

● Subscriber identity module (SIM)

● Two 5-band antennas built into display panel

 Wireless personal area network (WPAN) options:

● Bluetooth® module

● Supports no-WPAN option

External media
card

● One 54-mm ExpressCard slot

● Integrated SD flash media slot (SD/MMC support)

Ports ● 1394a port

● Digital erase pen

● Docking connector for HP 3-in-1 NAS Docking Station, HP Advanced Docking Station, HP Docking
Station, and HP External USB 2.0 MultiBay II Cradle

● Headphone connector

● Microphone connector

● Primary battery connector

● RJ-11 modem port

● RJ-45 Ethernet port

● SD card slot (SD/MMC support)

● Smart AC adapter connector

● Travel battery connector

● USB ports (2 ports; one port is powered and is not available when the computer is docked)

● VGA port (Dsub 15-pin) supporting 1600 × 1200 external resolution @ 75 Hz, hot plug/unplug, and
auto detect
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Category Description

Docking Docking support through HP Compaq 2710p-specific expansion base

Keyboard/pointing
devices

● Spill-resistant keyboard with embedded numeric keypad, pointing stick, and fingerprint reader

● Full-size, 19.05-mm pitch, 4.5-mm height keyboard

● One-way scrolling (vertical)

● Windows Vista® hardware Start button

● Durable key caps

Power
requirements

Primary batteries:

● 6-cell, 4.4-Wh, Li-ion battery with fuel gauge

● 6-cell, 2.0-Wh Li-ion battery (for Thailand only)

● Supports the HP 2700 Ultra-Slim Battery (which can also be used while the computer is docked)

65-watt Smart AC adapter with localized cable plug support and 3-wire plug

Security ● Support for Kensington security lock

● Optional integrated active smart card reader (installed in the ExpressCard slot)

● Integrated Infineon TPM 1.2 chip (soldered to PCB)

● Integrated USB-based fingerprint reader
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Category Description

Operating system Preinstalled:

● Windows Vista Business (32- and 64-bit) with Office 2007 Ready + One Note

● Windows Vista Business (32- and 64-bit) with Office 2007 Ready

● Windows Vista Business (32- and 64-bit) with Office 2007 Personal

● Windows® XP Tablet with Office 2007 Ready + One Note

● Windows XP Tablet with Office 2007 Ready

● Windows XP Tablet with Office 2007 Personal

Restore media:

● Windows Vista Business (32-bit)

● Windows Vista Business (64-bit)

● Windows XP Tablet PC Edition 2005

● DRDVD XP

● DRDVD Vista

Preinstalled with Office:

● Windows Vista Business (32-bit)

● Windows Vista Business (64-bit)

● Windows XP Tablet PC Edition 2005

● DRDVD XP

● DRDVD Vista

Web support: Windows Vista Enterprise 32 and Windows Vista Enterprise 64

Certified: Linux

Serviceability End-user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Memory module

● Power cord

● SIM

● Wireless modules
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2 External component identification

Top components
Display components

Item Component Description

(1) Integrated camera (select models only) Records video, captures still photographs, and transmits
streaming video for video conferencing.

(2) Camera light (select models only) On: The camera is recording or streaming video or capturing
a still photograph.

(3) Camera mode switch ● To use macro mode, slide the switch to the left. Macro
mode uses a focal length of approximately 10 cm for
capturing close-up images.

● To use normal mode, slide the switch to the right.
Normal mode uses a focal length of approximately 50
cm for capturing images within a standard range of
distance from the camera.

(4) Keyboard light Illuminates the keyboard in low-light conditions when the
keyboard light button is pressed.

(5) Keyboard light button Opens and turns on the keyboard light.

(6) HP Fingerprint Sensor (fingerprint reader) Allows a fingerprint logon to Windows instead of a password
logon.

(7) Internal microphones (2) Record sound and transmit sound for video conferencing.
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Item Component Description

(8) Convertible hinge Swivels the display and converts the computer from
traditional notebook mode into tablet mode or vice versa.

(9) Ambient light sensor Automatically adjusts the display brightness based on the
lighting conditions in your environment.

Buttons, switches, and pointing devices

Item Component Function

(1) Internal display switch Turns off the display if the display is closed while the power
is on.

(2) Pointing stick* Moves the pointer and selects or activates items on the
screen.

(3) Presentation button Starts the presentation feature.

(4) Volume mute button Mutes and restores speaker sound.

(5) Volume scroll zone Adjusts speaker volume:

● To decrease volume, slide your finger across the
volume scroll zone from right to left. You can also tap
or press the left half of the volume scroll zone.

● To increase volume, slide your finger across the
volume scroll zone from left to right. You can also tap
or press the right half of the volume scroll zone.

(6) Left pointing stick button* Functions like the left button on an external mouse.

(7) Right pointing stick button* Functions like the right button on an external mouse.

*This table describes factory settings. View or change pointing device preferences as follows:

● In Windows Vista, select Start > Control Panel > Hardware and Sound > Mouse.

● In Windows XP, select Start > Control Panel > Printers and Other Hardware > Mouse.
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Lights

Item Component Function

(1) Power light ● On: The computer is on.

● Blinking: The computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP).

● Blinking rapidly: An AC adapter with a higher power
rating should be connected.

● Off: The computer is off or in Hibernation.

(2) Battery light ● Amber: A battery is charging.

● Green: A battery is close to full charge capacity.

● Blinking amber: A battery that is the only available
power source has reached a low battery level. When
the battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the
computer are fully charged. If the computer is not
plugged into an external power source, the light stays
off until the battery reaches a low battery level.

(3) Drive light ● Blinking green: The hard drive is being accessed.

● Amber: HP 3D DriveGuard has temporarily parked the
internal hard drive.

(4) Caps lock light On: Caps lock is on.

(5) Volume mute light ● Off: Computer sound is on.

● On: Computer sound is off.

(6) Volume down light Blinking: The volume scroll zone is being used to decrease
speaker volume.
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Item Component Function

(7) Volume up light Blinking: The volume scroll zone is being used to increase
speaker volume.

(8) Num lock light On: Num lock is on or the embedded numeric keypad is
enabled.
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Keys

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in
combination with the fn key.
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Front components

Item Component Function

(1) Camera light (select models only) On: The camera is recording or streaming video or
capturing a still photograph.

(2) Camera mode switch ● To use macro mode, slide the switch to the left. Macro
mode uses a focal length of approximately 10 cm for
capturing close-up images.

● To use normal mode, slide the switch to the right.
Normal mode uses a focal length of approximately 50
cm for capturing images within a standard range of
distance from the camera.

(3) Keyboard light button Opens and turns on the keyboard light.

(4) External WWAN antenna button Opens the external WWAN antenna.

(5) External WWAN antenna Sends and receives wireless signals to communicate with
a WWAN.

(6) Power switch ● When the computer is off, slide the switch to the right
to turn on the computer.

● When the computer is on, slide the switch to the right
to shut down the computer.

● When the computer is in the Sleep state (Windows
Vista) or in Standby (Windows XP), slide the switch to
the right briefly to exit Sleep or Standby.

● When the computer is in Hibernation, slide the switch
to the right briefly to exit Hibernation.

If the computer has stopped responding and Windows®
shutdown procedures are ineffective, slide the switch to the
right and hold for at least 5 seconds to turn off the computer.

To learn more about your power settings, follow these
steps:

● In Windows Vista, select Start > Control Panel >
System and Maintenance > Power Options.

● In Windows XP, select Start > Control Panel >
Performance and Maintenance > Power Options.

(7) Display release latch Opens the computer.

(8) Bluetooth® compartment Contains an optional Bluetooth device.
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Rear components

Item Component Function

(1) Rotate button Rotates the screen image clockwise into 4 orientations:
landscape primary, landscape secondary, portrait primary,
and portrait secondary.

(2) Windows security button* ● While Windows is running, press the button with the
pen to enter the ctrl+alt+delete command.

● While the Computer Setup utility is running, press the
button with the pen to enter the reset command. The
computer resets and all unsaved information is lost.
The reset function can be used to restore functionality
when the system has become unresponsive.

(3) RJ-11 (modem) jack Connects a modem cable.

(4) RJ-45 (network) jack Connects a network cable.

(5) External monitor port Connects an external VGA monitor or projector.

(6) Power connector Connects an AC adapter.

*To protect your work and the system, the ctrl+alt+delete command cannot be entered using the ctrl, alt, and del keys on the
on-screen keyboard.
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Right-side components

Item Component Function

(1) HP Fingerprint Sensor (fingerprint reader) Allows a fingerprint logon to Windows instead of a
password logon.

(2) 1394 port Connects an optional IEEE 1394 or 1394a device, such as
a camcorder.

(3) Audio-out (headphone) jack Produces computer sound when connected to optional
powered stereo speakers, headphones, ear buds, a
headset, or television audio.

(4) Audio-in (microphone) jack Connects an optional computer headset microphone,
stereo array microphone, or monaural microphone.

(5) Media Card Reader Supports the following optional digital card formats: Secure
Digital (SD) Memory Card and MultiMediaCard (MMC).

(6) USB port Connects an optional USB device.

(7) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Left-side components

Item Component Description

(1) Pen slot Stores the pen.

(2) Vent Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(3) ExpressCard slot (select models only) Supports optional ExpressCards.

 Smart card reader (select models only) Supports smart cards and Java™ cards.

(4) Wireless light ● Blue: An integrated wireless device, such as a
wireless local area network (WLAN) device, the HP
Mobile Broadband Module, and/or a Bluetooth device,
is on.

● Amber: All wireless devices are off.

(5) Wireless switch Turns the wireless feature on or off, but does not create a
wireless connection.

NOTE: A wireless network must be set up in order to
establish a wireless connection.

(6) Info button Launches Info Center, which enables you to open various
software solutions.

(7) Powered USB port Provides power to a USB device, such as an optional
external MultiBay, if used with a powered USB cable.
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Bottom components

Item Component Function

(1) Battery bay Holds the battery.

(2) Speaker Produces sound.

(3) SIM slot Contains a SIM. The SIM slot is located inside the battery
bay.

(4) Vents (3) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is normal
for the internal fan to cycle on and off during routine
operation.

(5) Hard drive compartment Holds the hard drive, memory module slots, WLAN module
(select models only) and WWAN module (select models
only).

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module authorized
for use in the computer by the governmental agency that
regulates wireless devices in your country or region. If you
replace the module and then receive a warning message,
remove the module to restore computer functionality, and
then contact technical support through Help and Support.

(6) Docking connector Connects an optional docking device.

(7) Charge level indicator Displays the approximate remaining battery charge.

(8) Battery release latch Releases the battery from the battery bay.

(9) Accessory battery connector Connects an optional accessory battery.

(10) Accessory battery connector door Slides open to expose the accessory battery connector.

Bottom components 15



3 Illustrated parts catalog

Serial number location
When ordering parts or requesting information, provide the computer serial number and model number
located on the bottom of the computer.
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Computer major components

Item Description Spare part number

(1) 12.1-inch, WXGA, WVA display assemblies (include ambient light sensor, fingerprint reader, inverter board,
microphones, WLAN antenna cables, and WWAN antenna cables)

 Display assembly with camera and keyboard light 454679-001

 Display assembly with camera 454675-001

 Display assembly with keyboard light 454677-001

 Display assembly 454676-001

 Display internal components (not illustrated):

 Fingerprint reader board 454693-001

 Microphones (includes 2 receivers and cables) 454694-001

 External WWAN antenna 454688-001

(2) Keyboards (include pointing stick and pointing stick cable)
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Item Description Spare part number

 Belgium 454696-A41

 Brazil 454696-201

 The Czech Republic 454696-221

 Denmark 454696-081

 France 454696-041

 French Canada 454696-121

 Germany 454696-041

 Greece 454696-DJ1

 Hungary 454696-211

 Iceland 454696-DD1

 Israel 454696-BB1

 Italy 454696-061

 Japan 454696-291

 Latin America 454696-161

 The Netherlands and Europe 454696-B31

 Norway 454696-091

 Portugal 454696-131

 Russia 454696-251

 Saudi Arabia 454696-171

 Slovakia 454696-231

 Slovenia 454696-BA1

 South Korea 454696-AD1

 Spain 454696-071

 Sweden and Finland 454696-B71

 Switzerland 454696-111

 Taiwan 454696-AB1

 Thailand 454696-281

 Turkey 454696-141

 The United Kingdom 454696-031

 The United States 454696-001

 Plastics Kit (see Plastics Kit on page 24 for more Plastics Kit spare part information): 454685-001

(3a) Rear plastic bezel

(3b) ExpressCard slot bezel

(3c) Hard drive compartment cover (includes 6 captive screws, secured by C-clips)
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Item Description Spare part number

 Bluetooth module cover (not illustrated)

(4) Top cover (includes LED board and cable and display alignment guides) 454683-001

(5) RTC battery (includes double-sided tape) 454689-001

(6) Audio connector board (includes cable) 454690-001

(7) Bluetooth module (includes cable) 454691-001

(8) Speaker 454695-001

(9) Modem modules (include cable)

 For use only in Australia and New Zealand 443899-011

 For use only in North America 443899-001

(10) System boards (include replacement thermal material)

 Equipped with Intel Core Duo U7700 (1.33-GHz) processor (533-MHz FSB and 2-MB L2
cache)

469492-001

 Equipped with Intel Core Duo U7600 (1.20-GHz) processor (533-MHz FSB and 2-MB L2
cache)

455083-001

 Equipped with Intel Core Duo U7500 (1.06-GHz) processor (533-MHz FSB and 2-MB L2
cache)

455082-001

(11) Fan/heat sink assembly (includes replacement thermal material) 454692-001

(12) Base enclosure (includes display release latch and rubber feet) 455080-001

 Rubber Kit (not illustrated; includes 4 rubber feet, 5 Mylar screw covers, and 2 display
alignment guides)

454686-001

(13) Battery, 6-cell  

 4.4-Wh battery 454668-001

 2.0-Wh battery (for Thailand only) 464482-001

 Ultra-slim extended life battery 443157-001

(14) WLAN modules

 Broadcom 802.11a/b/g/n WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

436255-001
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Item Description Spare part number

 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon,
Cape Verde, the Cayman Islands, the Central African Republic, Chad, Chile, Colombia,
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark,
Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guam, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland,
Portugal, Puerto Rico, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San
Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada,
Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga,
Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

436256-001

 ● For use in Japan 436255-291

 Intel 802.11a/b/g/n WLAN modules:

 ● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay,
the United States, Venezuela, and Vietnam

441086-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

441086-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

441086-003

 ● For use in Japan 441086-291

 ● For use in South Korea 441086-AD1

 Broadcom 802.11a/b/g WLAN modules:

 ● For use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

441075-001
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 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands,
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama,
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of
Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago,
Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the
United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

441075-002

 ● For use in Japan 441075-291

 Intel 802.11a/b/g WLAN modules:

 ● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda,
Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican
Republic, Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India,
Indonesia, Malaysia, Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the
United States, Uruguay, Venezuela, and Vietnam

409407-001 and
441082-001

 ● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the
Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece,
Hungary, Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania,
Luxembourg, Malta, Monaco, the Netherlands, Norway, Oman, the Philippines, Poland,
Portugal, Qatar, Romania, Russia, Serbia and Montenegro, Singapore, Slovakia,
Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey, Ukraine, the
United Kingdom, and Uzbekistan

409407-002 and
441082-002

 ● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South
Korea

409497-001 and
441082-003

 ● For use in Japan 409497-291 and
441082-291

 Broadcom 802.11b/g WLAN modules:

 ● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and
the United States

441090-001
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 ● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia &
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cambodia, Cameroon, Cape Verde, the Central African Republic, Chad, Chile,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast, Jamaica,
Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon,
Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the
People's Republic of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe,
Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone,
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga,
Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-002

 ● For use in Japan 441090-291

 Intel 802.11b/g WLAN module for use in Thailand 409407-004

(15) WWAN modules

 Cingular HSDPA WWAN module 448673-002

 Sprint EV-DO WWAN module 451132-001

 Verizon EV-DO WWAN module 451131-001

 Vodafone HSDPA WWAN module 448672-002

 HP hs2300 HSDPA Mobile Broadband modules:  

 ● For use in Australia, Austria, Belgium, Croatia, Czech Republic, Denmark, Egypt,
Finland, France, Germany, Greece, Hong Kong, Hungary, India, Ireland, Israel, Italy,
Japan, the Netherlands, New Zealand, Poland, Portugal, Russia, Singapore, Slovakia,
Slovenia, South Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Turkey, and
the United Kingdom

459350-001

 ● For use in Argentina, Brazil, Canada, Chile, Mexico, the United States, and Venezuela 459351-001

(16) Memory modules (PC2-5300, 667-MHz, DDR2)

 2048-MB 454673-001

 1024-MB 454672-001

 512-MB 454674-001

(17) Hard drives (include isolator and connector cable)

 120-GB, 5400-rpm 488588-001

 120-GB, 4200-rpm 488587-001
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 100-GB, 4200-rpm 454671-001

 80-GB, 4200-rpm 454670-001

 60-GB, 4200-rpm 454669-001

 64-GB solid-state drive 463602-001

(18) Heat shield, system board 458406-001

 Cable Kit (not illustrated, includes Bluetooth module cable and audio connector board
cable)

454682-001

 Smart card reader module (not illustrated, inserts into ExpressCard slot) 454680-001
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Plastics Kit

Item Description Spare part number

 Plastics Kit: 454685-001

(1) Rear plastic bezel

(2) ExpressCard slot bezel

(3) Hard drive compartment cover (includes 6 captive screws, secured by C-clips)

(4) Bluetooth module cover

Miscellaneous parts
Description Spare part number

65-watt AC adapter, slim (HP Smart AC Adapter) 391172-001

External MultiBay II 366143-001

External MultiBay II power cable and stand 366144-001

HP 2700 Ultra-Slim Expansion Base 455953-001

MultiBay 8X DVD-ROM Drive 373314-001

MultiBay 24X DVD/CD-RW Combo Drive 373315-001

Nylon carrying case 325814-001

Stylus pen with tether 454681-001

USB 1.1 diskette drive 359118-001

Power cords:

For use in Asia Pacific countries and regions 383496-371

For use in Australia 383496-011

For use in Brazil 383496-201

For use in Denmark 383496-081

For use in Europe, the Middle East, and Africa 383496-021
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For use in India 383496-D61

For use in Israel 383496-BB1

For use in Italy 383496-061

For use in Japan 383496-291

For use in the People's Republic of China 383496-AA1

For use in South Africa 383496-AR1

For use in South Korea 383496-AD1

For use in Switzerland 383496-111

For use in Thailand 383496-281

For use in the United Kingdom 383496-031

For use the United States 383496-001

Screw Kit

● Phillips PM2.5×7.0 captive screw

● Phillips PM2.5×7.0 screw

● Phillips PM2.5×4.0 screw

● Black Phillips PM2.0×6.0 screw

● Silver Phillips PM2.0×6.0 screw

● Phillips PM2.0×5.0 captive screw

● Phillips PM2.0×5.0 screw

● Phillips PM2.0×4.0 screw

● Phillips PM2.0×3.0 screw

● Torx T8M2.0×8.0 screw

● Torx T8M2.0×5.0 screw

454687-001
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Spare part
number

Description

383496-001 Power cord for use in the United States

383496-011 Power cord for use in Australia

383496-021 Power cord for use in Europe

383496-031 Power cord for use in the United Kingdom

383496-061 Power cord for use in Italy

383496-081 Power cord for use in Denmark

383496-111 Power cord for use in Switzerland

383496-201 Power cord for use in Brazil

383496-281 Power cord for use in Thailand

383496-291 Power cord for use in Japan

383496-371 Power cord for use in Asia Pacific countries and regions

383496-AA1 Power cord for use in the People's Republic of China

383496-AD1 Power cord for use in South Korea

383496-AR1 Power cord for use in South Africa

383496-BB1 Power cord for use in Israel

383496-D61 Power cord for use in India

391172-001 65-watt AC adapter, slim (HP Smart AC Adapter)

409407-001 Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

409407-002 Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

409407-004 Intel 802.11a/b/g WLAN module for use in Thailand

409497-291 Intel 802.11a/b/g WLAN module for use in Japan

436255-001 Broadcom 802.11a/b/g/n WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

436255-291 Broadcom 802.11a/b/g/n WLAN module for use in Japan
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436256-001 Broadcom 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman Islands, the
Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador,
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius,
Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, the People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto Rico, the
Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia,
Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia,
Turkey, Turkmenistan, Tuvalu, Uganda, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-001 Broadcom 802.11a/b/g WLAN module for use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin
Islands, and the United States

441075-002 Broadcom 802.11a/b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central
African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea,
Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao
Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts &
Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the
United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

441075-291 Broadcom 802.11a/b/g WLAN module for use in Japan

441082-001 Intel 802.11a/b/g WLAN module for use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay, Venezuela, and Vietnam

441082-002 Intel 802.11a/b/g WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441082-003 Intel 802.11a/b/g WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea
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441082-291 Intel 802.11a/b/g WLAN module for use in Japan

441086-001 Intel 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados,
Bermuda, Brunei, Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic,
Ecuador, El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia, Mexico,
Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States, Venezuela, and Vietnam

441086-002 Intel 802.11a/b/g/n WLAN module for use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia,
Cyprus, the Czech Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta, Monaco, the
Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania, Russia, Serbia and
Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Turkey,
Ukraine, the United Kingdom, and Uzbekistan

441086-003 Intel 802.11a/b/g/n WLAN module for use in Australia, New Zealand, Pakistan, the People's Republic of China,
and South Korea

441086-291 Intel 802.11a/b/g/n WLAN module for use in Japan

441086-AD1 Intel 802.11a/b/g/n WLAN module for use in South Korea

441090-001 Broadcom 802.11b/g WLAN module for use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S.
Virgin Islands, and the United States

441090-002 Broadcom 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua &
Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia,
Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory Coast,
Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia,
Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta,
the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic of
China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania, Russia, Rwanda,
Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia and Montenegro, the Seychelles,
Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain,
Sri Lanka, St. Kitts & Nevis, St. Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland,
Taiwan, Tajikistan, Tanzania, Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-291 Broadcom 802.11b/g WLAN module for use in Japan

443157-001 Ultra-slim extended life battery

443899-001 Modem module for use in North America (includes modem module cable)

443899-011 Modem module for use in Australia and New Zealand (includes modem module cable)

448672-002 Vodafone HSDPA WWAN module

448673-002 Cingular HSDPA WWAN module

451131-001 Verizon EV-DO WWAN module

451132-001 Sprint EV-DO WWAN module

454668-001 6-cell, 4.4-Wh battery
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454669-001 60-GB, 4200-rpm hard drive (includes isolator and connector cable)

454670-001 80-GB, 4200-rpm hard drive (includes isolator and connector cable)

454671-001 100-GB, 4200-rpm hard drive (includes isolator and connector cable)

454672-001 1024-MB memory module (PC2-5300, 667-MHz, DDR2)

454673-001 2048-MB memory module (PC2-5300, 667-MHz, DDR2)

454674-001 512-MB memory module (PC2-5300, 667-MHz, DDR2)

454675-001 12.1-inch, WXGA, WVA display assembly with camera module (includes ambient light sensor, fingerprint
reader, inverter board, microphones, WLAN antenna cables, and WWAN antenna cables)

454676-001 12.1-inch, WXGA, WVA display assembly (includes ambient light sensor, fingerprint reader, inverter board,
microphones, WLAN antenna cables, and WWAN antenna cables)

454677-001 12.1-inch, WXGA, WVA display assembly with keyboard light (includes ambient light sensor, fingerprint reader,
inverter board, microphones, WLAN antenna cables, and WWAN antenna cables)

454679-001 12.1-inch, WXGA, WVA display assembly with camera module and keyboard light (includes ambient light
sensor, fingerprint reader, inverter board, microphones, WLAN antenna cables, and WWAN antenna cables)

454680-001 Smart card reader module (inserts into ExpressCard slot)

454681-001 Stylus pen with tether

454682-001 Cable Kit (includes Bluetooth module cable and audio connector board cable)

454683-001 Top cover (includes LED board and cable and display alignment guides)

454685-001 Plastics Kit (see Plastics Kit on page 24 for more Plastics Kit spare part information)

454686-001 Rubber Kit (includes 4 rubber feet, 5 Mylar screw covers, and 2 display alignment guides)

454687-001 Screw Kit

454688-001 External WWAN antenna

454689-001 RTC battery (includes double-sided tape)

454690-001 Audio connector board (includes cable)

454691-001 Bluetooth module (includes cable)

454692-001 Fan/heat sink assembly (includes replacement thermal material)

454693-001 Fingerprint reader

454694-001 Microphone

454695-001 Speaker

454696-001 Keyboard for use in the United States

454696-031 Keyboard for use in the United Kingdom

454696-041 Keyboard for use in France

454696-051 Keyboard for use in Germany

454696-061 Keyboard for use in Italy

454696-071 Keyboard for use in Spain
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454696-081 Keyboard for use in Denmark

454696-091 Keyboard for use in Norway

454696-111 Keyboard for use in Switzerland

454696-121 Keyboard for use in French Canada

454696-131 Keyboard for use in Portugal

454696-141 Keyboard for use in Turkey

454696-161 Keyboard for use in Latin America

454696-171 Keyboard for use in Saudi Arabia

454696-201 Keyboard for use in Brazil

454696-211 Keyboard for use in Hungary

454696-221 Keyboard for use in the Czech Republic

454696-231 Keyboard for use in Slovakia

454696-251 Keyboard for use in Russia

454696-281 Keyboard for use in Thailand

454696-291 Keyboard for use in Japan

454696-A41 Keyboard for use in Belgium

454696-AB1 Keyboard for use in Taiwan

454696-AD1 Keyboard for use in South Korea

454696-B31 Keyboard for use in the Netherlands

454696-B71 Keyboard for use in Sweden and Finland

454696-BA1 Keyboard for use in Slovenia

454696-BB1 Keyboard for use in Israel

454696-DD1 Keyboard for use in Iceland

454696-DJ1 Keyboard for use in Greece

455080-001 Base enclosure (includes display release latch and rubber feet)

455082-001 System board equipped with Intel Core 2 Duo U7500 1.06-MHz processor (includes replacement thermal
material)

455083-001 System board equipped with Intel Core 2 Duo U7600 1.20-MHz processor (includes replacement thermal
material)

455953-001 HP 2700 Ultra-Slim Expansion Base

458406-001 Heat shield, system board

459350-001 HP hs2300 HSDPA Mobile Broadband module for use in Australia, Austria, Belgium, Croatia, Czech Republic,
Denmark, Egypt, Finland, France, Germany, Greece, Hong Kong, Hungary, India, Ireland, Israel, Italy, Japan,
the Netherlands, New Zealand, Poland, Portugal, Russia, Singapore, Slovakia, Slovenia, South Africa, South
Korea, Spain, Sweden, Switzerland, Taiwan, Turkey, and the United Kingdom
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Spare part
number

Description

459351-001 HP hs2300 HSDPA Mobile Broadband module for use in Argentina, Brazil, Canada, Chile, Mexico, the United
States, and Venezuela

459912-001 Foil strip—attaches to the system board metal shield

463602-001 64-GB solid-state drive

464260-001 Metal shield—installed under wireless modules

464482-001 2.0-Wh battery (for Thailand only)

469492-001 System board equipped with Intel Core 2 Duo U7700 1.33-MHz processor (includes replacement thermal
material)

486565-001 Pointing stick cap, black rubber (20 pieces)

488587-001 120-GB, 4200-rpm hard drive (includes isolator and connector cable)

488588-001 120-GB, 5400-rpm hard drive (includes isolator and connector cable)

Sequential part number listing 31



4 Removal and replacement procedures

Preliminary replacement requirements
Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screwdriver

● Magnetic screwdriver

● Phillips P0 and P1 screwdrivers

● Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
Using excessive force during disassembly and reassembly can damage plastic parts. Use care when
handling the plastic parts. Apply pressure only at the points designated in the maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with extreme
care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some protection,
but in many cases, ESD contains enough power to alter device parameters or melt silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you area ready to install them.

Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials are
selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastic Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Unknown user password
If the computer you are servicing has an unknown user password, follow these steps to clear the
password:

NOTE: These steps also clear CMOS.

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the real-time clock (RTC) battery (see RTC battery on page 57).

6. Wait approximately 5 minutes.

7. Replace the RTC battery and reassemble the computer.

8. Connect AC power to the computer. Do not reinsert any batteries at this time.

9. Turn on the computer.

All passwords and all CMOS settings have been cleared.

Preliminary replacement requirements 37



Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 44 screws, in 11 different sizes, that must be removed, replaced, or loosened
when servicing the computer. Make special note of each screw size and location during removal and
replacement.

Serial number
Report the computer serial number to HP when requesting information or ordering spare parts. The
serial number is located on the bottom of the computer.

Computer feet
The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare
part number 454686-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

6-cell, 4.4-Wh battery 454668-001

6-cell, 2.0-Wh battery (for Thailand only) 464482-001

Ultra-slim extended life battery 443157-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

Remove the battery:

1. Turn the computer upside down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Pivot the battery upward (2) and remove it from the computer (3).

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

Remove the SIM:

1. Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Hard drive
NOTE: All hard drive spare part kits include an isolator and connector cable.

Description Spare part number

120-GB, 5400-rpm hard drive 488588-001

120-GB, 4200-rpm hard drive 488587-001

100-GB, 4200-rpm hard drive 454671-001

80-GB, 4200-rpm hard drive 454670-001

60-GB, 4200-rpm hard drive 454669-001

64-GB solid-state drive 463602-001

Before removing the hard drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

Remove the hard drive:

1. Loosen the six Phillips PM2.0×5.0 captive screws (1) that secure the hard drive compartment cover
to the computer.

2. Lift the rear edge of the hard drive compartment cover (2), swing it up and forward, and remove
the cover. The hard drive compartment cover is included in the Plastics Kit, spare part number
454685-001.

3. Remove the two Phillips PM2.0×3.0 screws (1) that secure the hard drive bracket to the computer.
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4. Remove the hard drive bracket (2).

5. Disconnect the hard drive connector (1) from the system board.

6. Release the hard drive (2) by sliding it to the right.

7. Lift the hard drive (3) straight up to remove it from the hard drive compartment.

Reverse this procedure to install the hard drive.
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WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Broadcom 802.11a/b/g/n WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

436255-001

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belgium, Belize, Benin, Bermuda, Bolivia, Bosnia & Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Cayman
Islands, the Central African Republic, Chad, Chile, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic,
East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji,
Finland, France, French Guiana, Gabon, Gambia Georgia, Germany, Ghana, Gibraltar,
Greece, Grenada, Guadeloupe, Guam, Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Italy, the Ivory Coast, Jamaica, Jordan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Netherlands, New Zealand, Nicaragua,
Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, the
People's Republic of China, Peru, the Philippines, Poland, Portugal, Puerto Rico, the Republic
of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi
Arabia, Senegal, Serbia and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia,
Slovenia, the Solomon Islands, Somalia, South Africa, Spain, Sri Lanka, St. Kitts & Nevis, St.
Lucia, St. Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

436256-002

● For use in Japan 436255-291

Intel 802.11a/b/g/n WLAN modules:

● For use in Antigua and Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, Uruguay, the United States,
Venezuela, and Vietnam

441086-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441086-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441086-003

● For use in Japan 441086-291

● For use in South Korea 441086-AD1

Broadcom 802.11a/b/g WLAN modules:

● For use in Canada, Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the United
States

441075-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of
China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic,
Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El
Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissa, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine,
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela,
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441075-002

● For use in Japan 441075-291

Intel 802.11a/b/g WLAN modules:

● For use in Antigua & Barbuda, Argentina, Aruba, the Bahamas, Barbados, Bermuda, Brunei,
Canada, the Cayman Islands, Chile, Colombia, Costa Rica, the Dominican Republic, Ecuador,
El Salvador, Guam, Guatemala, Haiti, Honduras, Hong Kong, India, Indonesia, Malaysia,
Mexico, Panama, Paraguay, Peru, Saudi Arabia, Taiwan, the United States, Uruguay,
Venezuela, and Vietnam

441082-001 and
409407-001

● For use in Austria, Azerbaijan, Bahrain, Belgium, Brazil, Bulgaria, Croatia, Cyprus, the Czech
Republic, Denmark, Egypt, Estonia, Finland, France, Georgia, Germany, Greece, Hungary,
Iceland, Ireland, Israel, Italy, Latvia, Lebanon, Liechtenstein, Lithuania, Luxembourg, Malta,
Monaco, the Netherlands, Norway, Oman, the Philippines, Poland, Portugal, Qatar, Romania,
Russia, Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka,
Sweden, Switzerland, Turkey, Ukraine, the United Kingdom, and Uzbekistan

441082-002 and
409407-002

● For use in Australia, New Zealand, Pakistan, the People's Republic of China, and South Korea 441082-003 and
409407-003

● For use in Japan 441082-291 and
409407-291

Broadcom 802.11b/g WLAN modules:

● For use in Canada, the Cayman Islands, Guam, Puerto Rico, the U.S. Virgin Islands, and the
United States

441090-001
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Description Spare part number

● For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua & Barbuda, Argentina,
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados,
Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia & Herzegovina, Botswana,
Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cambodia,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, Colombia, Comoros, the
Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the
Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissa, Guyana,
Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, the Ivory
Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kuwait, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar,
Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania,
Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger,
Nigeria, Norway, Oman, Palau, Panama, Papua New Guinea, Paraguay, the People's Republic
of China, Peru, the Philippines, Poland, Portugal, Qatar, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome & Principe, Saudi Arabia, Senegal, Serbia
and Montenegro, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon
Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts & Nevis, St. Lucia, St.
Vincent & Grenada, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Thailand, Togo, Tonga, Trinidad & Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

441090-002

● For use in Japan 441090-291

Intel 802.11b/g WLAN module for use in Thailand 409407-004

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive compartment cover (see Hard drive on page 41).

Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the computer is
equipped with an 802.11a/b/g/n WLAN module, a yellow WLAN antenna cable (2) is connected to
the middle terminal on the WLAN module. Disconnect this cable.

2. Remove the two Phillips PM2.5×4.0 screws (3) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WLAN module (4) by pulling the module away from the slot at an angle.

NOTE: WLAN modules are designed with a notch (5) to prevent incorrect installation.

Reverse this procedure to install the WLAN module.
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WWAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Cingular HSDPA WWAN module 448673-002

Sprint EV-DO WWAN module 451132-001

Verizon EV-DO WWAN module 451131-001

Vodafone HSDPA WWAN module 448672-002

HP hs2300 HSDPA Mobile Broadband modules:  

● For use in Australia, Austria, Belgium, Croatia, Czech Republic, Denmark, Egypt, Finland,
France, Germany, Greece, Hong Kong, Hungary, India, Ireland, Israel, Italy, Japan, the
Netherlands, New Zealand, Poland, Portugal, Russia, Singapore, Slovakia, Slovenia, South
Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, Turkey, and the United Kingdom

459350-001

● For use in Argentina, Brazil, Canada, Chile, Mexico, the United States, and Venezuela 459351-001

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive compartment cover (see Hard drive on page 41).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.

2. Remove the two Phillips PM2.5×4.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: WWAN modules are designed with a notch (4) to prevent incorrect installation.

Reverse this procedure to install the WWAN module.
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Memory module

Description Spare part number

2048-MB (PC2-5300, 667-MHz, DDR2) 454673-001

1024-MB (PC2-5300, 667-MHz, DDR2) 454672-001

512-MB (PC2-5300, 667-MHz, DDR2) 454674-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive compartment cover (see Hard drive on page 41).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)

2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: Memory modules are designed with a notch (3) to prevent incorrect installation into the
memory module slot.

Reverse this procedure to install the memory module.
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Keyboard

For use in: Spare part number For use in: Spare part number

Belgium

Brazil

The Czech Republic

Denmark

France

French Canada

Germany

Greece

Hungary

Iceland

Israel

Italy

Japan

Latin America

The Netherlands and Europe

454696-A41

454696-201

454696-221

454696-081

454696-051

454696-121

454696-041

454696-DJ1

454696-211

454696-DD1

454696-BB1

454696-061

454696-291

454696-161

454696-B31

Norway

Portugal

Russia

Saudi Arabia

Slovakia

Slovenia

South Korea

Spain

Sweden and Finland

Switzerland

Taiwan

Thailand

Turkey

The United Kingdom

The United States

454696-091

454696-131

454696-251

454696-171

454696-231

454696-BA1

454696-AD1

454696-071

454696-B71

454696-111

454696-AB1

454696-281

454696-141

454696-031

454696-001

Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive compartment cover (see Hard drive on page 41).
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Remove the keyboard:

1. Remove the following:

(1) One small Mylar screw cover. The screw covers detailed in this section are available in the
Rubber Kit, spare part number 454686-001.

(2) One medium Mylar screw cover.

(3) Six Torx T8M2.0×8.0 screws.

2. Turn the computer display-side up, with the front toward you.

3. Open the computer as far as possible.

4. Lift the rear edge of the keyboard (1) and slide it (2) back until the pointing stick cable is accessible.

5. Release the zero insertion force (ZIF) connector (3) to which the pointing stick cable is attached,
and disconnect the pointing stick cable (4) from the system board.

6. Swing the top edge of the keyboard (1) up and forward until it rests upside down on the palm rest.
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7. Release the ZIF connector (2) to which the keyboard cable is attached, and disconnect the
keyboard cable (3) from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.

Rear plastic bezel
NOTE: The rear plastic bezel is included in the Plastics Kit, spare part number 454685-001.

Before removing the rear plastic bezel, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the hard drive compartment cover (see Hard drive on page 41).

6. Remove the keyboard (see Keyboard on page 50).

Remove the rear plastic bezel:

1. Turn the computer upside down, with the rear panel toward you.
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2. Remove the two Torx T8M2.0×5.0 screws that secure the rear plastic bezel to the computer.

3. Turn the computer right-side up, with the rear panel toward you.

4. Open the computer to an upright position.

5. Remove the rear plastic bezel by pulling it away from the computer.

Reverse this procedure to install the rear plastic bezel.
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Top cover

Description Spare part number

Top cover (includes LED board and cable and display alignment guides) 454683-001

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.
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2. Remove the following:

(1) One small Mylar screw cover. All Mylar screw covers detailed in this section are included in the
Rubber Kit, spare part number 454686-001.

(2) Three Torx T8M2.0×8.0 screws.

(3) Two large Mylar screw covers. The screw covers detailed in this section are included in the
Rubber Kit, spare part number 454686-001.

(4) Two Torx T8M2.0×4.0 screws.

3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the ZIF connector (1) to which the LED board cable is connected and disconnect the LED
board cable from the system board.

6. Remove the two Phillips PM2.0×5.0 screws (2) that secure the top cover to the computer.

7. Lift the front edge of the top cover (3) until it rests at an angle.
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8. Remove the top cover (4) by pulling it away from the computer at an angle.

Reverse this procedure to install the top cover.
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RTC battery
NOTE: Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all
passwords and CMOS settings to be cleared.

Description Spare part number

RTC battery (includes double-sided tape) 454689-001

Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Remove the RTC battery (2).

Reverse this procedure to install the RTC battery.
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Audio connector board

Description Spare part number

Audio connector board (includes cable) 454690-001

Before removing the audio connector board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

Remove the audio connector board:

1. Release the ZIF connector (1) to which the audio connector board cable is connected and
disconnect the audio connector board cable (2) from the system board. The audio connector board
cable is included with the audio connector board and is also available in the Cables Kit, spare part
number 454682-001.

2. Remove the Phillips PM2.0×5.0 screw (3) that secures the audio connector board to the base
enclosure.

3. Remove the audio connector board and cable (4).
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Reverse this procedure to install the audio connector board.

Bluetooth module

Description Spare part number

Bluetooth (includes cable) 454691-001

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

e. Audio connector board (see Audio connector board on page 58)

Remove the Bluetooth® module:

1. Disconnect the Bluetooth module cable (1) from the system board.

2. Remove the Bluetooth module cable from the clips (2) built into the base enclosure. The Bluetooth
module cable is included with the Bluetooth module and is also available in the Cables Kit, spare
part number 454682-001.

3. Remove the Phillips PM2.0×5.0 screw (3) that secures the Bluetooth module to the base enclosure.

Component replacement procedures 59



4. Remove the Bluetooth module and cable (4) from the base enclosure.

Reverse this procedure to install the Bluetooth module.

Speaker

Description Spare part number

Speaker 454695-001

Before removing the speaker, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

e. Audio connector board (see Audio connector board on page 58)

f. Bluetooth module (see Bluetooth module on page 59)
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Remove the speaker:

1. Disconnect the speaker cable (1) from the system board.

2. Remove the speaker cable (2) from the clip built into the base enclosure.

3. Remove the Phillips PM2.0×6.0 screw (3) that secures the speaker to the base enclosure.

4. Remove the speaker (4) from the base enclosure.

Reverse this procedure to install the speaker.
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Display assembly
NOTE: All display assembly spare part kits include an ambient light sensor, fingerprint reader,
microphones, inverter board, WLAN antenna cables, and WWAN antenna cables

Description Spare part number

Display assembly with camera and keyboard light 454679-001

Display assembly with camera 454675-001

Display assembly with keyboard light 454677-001

Display assembly 454676-001

Before removing the display assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Disconnect the wireless antenna cables from the WLAN module (see WLAN module on page 43)
and the WWAN module (see WWAN module on page 47).

6. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

Remove the display assembly:

1. Place the display into an upright position.

2. Disconnect the following cables from the system board:

(1) Fingerprint reader board cable

(2) Camera cable

(3) Keyboard light cable
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3. Remove the wireless antenna cables (4) from the hole in the system board and remove the cables
from the clips built into the system board shield.

4. Remove the two Phillips PM2.0×6.0 screws (1) that secure the display panel cable to the system
board.

5. Disconnect the display panel cable (2) from the system board.

6. Remove the Phillips PM2.0×4.0 screw (3) that secures the display converter cable to the system
board.

7. Disconnect the display converter cable (4) from the system board.

CAUTION: The display assembly will be unsupported when the following screws are removed.
To prevent damage to the display assembly, support it before removing the screws.

8. Remove the four Phillips PM2.5×7.0 screws (1) that secure the display assembly to the computer.
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9. Lift the display assembly straight up and remove it (2).

Reverse this procedure to install the display assembly.
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System board
NOTE: All system board spare part kits include replacement thermal material.

Description Spare part number

Equipped with Intel Core Duo U7700 (1.33-GHz) processor (533-MHz FSB and 2-MB L2 cache) 469492-001

Equipped with Intel Core Duo U7600 (1.20-GHz) processor (533-MHz FSB and 2-MB L2 cache) 455083-001

Equipped with Intel Core Duo U7500 (1.06-GHz) processor (533-MHz FSB and 2-MB L2 cache) 455082-001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

e. Display assembly (see Display assembly on page 62)

When replacing the system board, be sure that the following components are removed from the defective
system board and installed on the replacement system board:

● SIM (see SIM on page 40)

● Memory modules (see Memory module on page 49)

● RTC battery (see RTC battery on page 57)

● Fan/heat sink assembly (see Fan/heat sink assembly on page 68)

● Modem module (see Modem module on page 71)

Remove the system board:

1. Position the computer with the left side toward you.

2. Press the ExpressCard slot bezel (1) to release it from the ExpressCard slot. (The ExpressCard
slot bezel is partially ejected from the ExpressCard slot.) The ExpressCard slot bezel is included
in the Plastics Kit, spare part number 454685-001.
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3. Remove the ExpressCard slot bezel (2).

4. Position the computer with the front toward you.

5. Remove the Phillips PM2.0×5.0 screw that secures the system board to the base enclosure.

6. Position the computer with the rear panel toward you.

7. Use the optical drive connector (1) to lift the front edge of the system board (2) until it rests at an
angle.
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8. Remove the system board (3) by sliding it away from the base enclosure at an angle.

You can replace the heat shield that sits atop the system board using spare part number 458406-001.

Reverse the preceding procedure to install the system board.

When installing the system board, you may need to replace the two shields listed below:

● Sheet metal shield that fits into the wireless compartment under the wireless modules, spare part
number 464260-001.

To install the shield, align the holes in the shield with the posts in the wireless compartment, and
then press the shield firmly into place.
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● Thin foil-type strip that fits onto the heat shield atop the system board, spare part number
459912-001.

To install the strip, place it into the slot on the heat shield, making sure the strip is under the tabs
in the slot.

Fan/heat sink assembly

Description Spare part number

Fan/heat sink assembly (includes replacement thermal material) 454692-001

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

e. Display assembly (see Display assembly on page 62)

f. System board (see System board on page 65)
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Remove the fan/heat sink assembly:

1. Disconnect the fan cable from the system board.

2. Turn the system board upside down with the front toward you.

3. Loosen the six Phillips PM2.5×7.0 captive screws (1) that secure the fan/heat sink assembly to the
base enclosure in the 1, 2, 3, 4, 5, 6 sequence stamped into the fan/heat sink assembly.

4. Remove the fan/heat sink assembly (2).

NOTE: Due to the adhesive quality of the thermal material located between the processor heat
sink and system board components, it may be necessary to move the processor heat sink from
side to side to detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) and
(2), the processor (3), and graphics system component (4) each time the heat sink is removed.
Replacement thermal material is included with all system board and fan/heat sink assembly spare part
kits.
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Reverse this procedure to install the fan/heat sink assembly.

NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side
of the computer.

The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are affected
by high external temperatures, system power consumption, power management/battery conservation
configurations, battery fast charging, and software requirements. Exhaust air is displaced through the
ventilation grill located on the left side of the computer.
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Modem module
NOTE: All modem module spare part kits include a modem module cable.

Description Spare part number

For use in all countries and regions except Australia, Brazil, and New Zealand 443899-001

For use only in Australia and New Zealand 443899-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and
then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 39).

5. Remove the following components:

a. Hard drive compartment cover (see Hard drive on page 41)

b. Keyboard (see Keyboard on page 50)

c. Rear plastic bezel (see Rear plastic bezel on page 52)

d. Top cover (see Top cover on page 54)

e. Display assembly (see Display assembly on page 62)

f. System board (see System board on page 65)

Remove the modem module:

1. Turn the system board upside down, with the front toward you.

2. Remove the two Phillips PM2.5×4.0 screws (1) that secure the modem module to the system board.

3. Lift the modem module (2) straight up to disconnect it from the system board.
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4. Disconnect the modem module cable (3) from the modem module.

Reverse this procedure to install the modem module.
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5 Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.

NOTE: Pointing devices are not supported in Computer Setup. You must use the keyboard to navigate
and make selections.

NOTE: An external keyboard connected by USB can be used with Computer Setup only if USB legacy
support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer.

2. Before Windows® opens and while the "F10 = ROM Based Setup" message is displayed in the
lower-left corner of the screen, press f10.
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Using Computer Setup
Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and
System Configuration menus.

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

Because Computer Setup is not Windows-based, it does not support the TouchPad. Navigation
and selection are by keystroke:

● To choose a menu or a menu item, use the arrow keys.

● To select an item, press enter.

● To close open dialog boxes and return to the main Computer Setup screen, press esc.

● To view navigation information, press f1.

● To change the language, press f2.

2. Select the File, Security, Diagnostics, or System Configuration menu.

3. To exit Computer Setup, choose one of the following methods:

● To exit Computer Setup without saving your preferences, use the arrow keys to select File >
Ignore Changes and Exit. Then follow the instructions on the screen.

● To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

Restoring factory settings in Computer Setup
To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Open Computer Setup by turning on or restarting the computer, and then pressing f10 while the
"F10 = ROM Based Setup" message is displayed in the lower-left corner of the screen.

2. Use the arrow keys to select File > Restore defaults, and then press enter.

3. When the confirmation dialog box opens, press f10.

4. To save your preferences and exit Computer Setup, use the arrow keys to select File > Save
Changes and Exit. Then follow the instructions on the screen.

Your preferences go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.

NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer.

File menu

Select To do this

System information ● View identification information for the computer and the batteries in the
system.

● View specification information for the processor, cache and memory size,
system ROM, video revision, and keyboard controller version.

Restore defaults Replace the configuration settings in Computer Setup with the original factory
settings. (Password settings and security settings are not changed when you
restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart the
computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the
computer. Your changes go into effect when the computer restarts.
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Security menu

Select To do this

Setup password Enter, change, or delete a setup password.

Power-On password Enter, change, or delete a power-on password.

Password options ● Enable/disable stringent security.

● Enable/disable password requirement on computer restart.

DriveLock passwords ● Enable/disable DriveLock on any computer hard drive and on optional
MultiBay hard drives.

● Change a DriveLock user password or master password.

NOTE: DriveLock settings are accessible only when you enter Computer Setup
by turning on (not restarting) the computer.

Smart Card security Enable/disable support for smart card and Java™ Card power-on authentication.

NOTE: Power-on authentication for smart cards is supported only on computers
with optional smart card readers.

NOTE: You must have an administrator password to change this setting.

TPM Embedded Security Enable/disable support for Trusted Platform Module (TPM) Embedded Security,
which protects the computer from unauthorized access to owner functions
available in Embedded Security for ProtectTools. For more information, refer to
the ProtectTools software Help.

NOTE: You must have a setup password to change this setting.

System IDs Enter user-defined computer asset tracking number and ownership tag.

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive. The
following options are available:

● Fast: Runs the Disk Sanitizer erase cycle once.

● Optimum: Runs the Disk Sanitizer erase cycle 3 times.

● Custom: Allows you to select the desired number of Disk Sanitizer erase
cycles from a list.

CAUTION: If you run Disk Sanitizer, the data on the primary hard drive is
destroyed permanently.

Diagnostics menu

Select To do this

Hard Drive Self-Test options Run a comprehensive self-test on any hard drive in the system or on any optional
MultiBay hard drive.

Memory Check Run a comprehensive check on system memory.

Startup Check (select models only) Verify the system components needed for starting the computer.
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System Configuration menu
NOTE: Some of the listed System Configuration options may not be supported by your computer.

Select To do this

Language (or press f2) Change the Computer Setup language.

Boot options ● Set f9, f10, and f12 delay when starting up.

● Enable/disable CD-ROM boot.

● Enable/disable floppy boot.

● Enable/disable internal network adapter boot and set the boot mode (PXE or
RPL).

● Enable/disable MultiBoot, which sets a boot order that can include most boot
devices in the system.

● Set the Express Boot Popup delay in seconds.

● Set the boot order.

Device configurations ● Swap the functions of the fn key and left ctrl key.

● Enable/disable multiple standard pointing devices at startup. (To set the
computer to support only a single, usually nonstandard, pointing device at
startup, select Disable.)

● Enable/disable USB legacy support. When enabled, USB legacy support
allows the following:

◦ Use of a USB keyboard, mouse, and hub in Computer Setup even when
a Windows operating system is not running.

◦ Startup from bootable USB devices, including a hard drive, diskette
drive, or optical drive connected by a USB port to the computer or to an
optional docking device (select models only).

● Select a parallel port mode: EPP (Enhanced Parallel Port), standard,
bidirectional, or ECP (Enhanced Capabilities Port).

● Enable/disable BIOS DMA data transfers.

● Enable/disable fan always on while connected to an AC outlet.

● Enable/disable Intel® Data Execution Prevention or AMD® PSAE Execution
Disable. When enabled, the processor can disable some virus code
execution, which helps to improve computer security.

● Enable/disable LAN Power Save. When enabled, saves power by turning off
the LAN when not in use.

● Enable/disable SATA Native Mode.

● Enable/disable Dual Core CPU.

● Enable/disable Secondary Battery Fast Charge.

● Choose Bit-shift or LBA assisted HDD Translation Mode.

● Enable/disable Windows direct application launcher.

● Enable/disable HP Lockout.
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Select To do this

Built-In Device Options ● Enable/disable embedded WWAN Device Radio.

● Enable/disable embedded WLAN Device Radio.

● Enable/disable embedded Bluetooth® Device Radio.

● Enable/disable LAN/WLAN Switching. When enabled, switches to a WLAN
when a LAN is either unavailable or disconnected.

● Enable/disable Wake on LAN from Off.

● Enable/disable the ambient light sensor.

Port Options ● Enable/disable the serial port.

● Enable/disable the parallel port.

● Enable/disable the flash media reader.

● Enable/disable the USB port.

CAUTION: Disabling the USB port also disables MultiBay devices and
ExpressCard devices on the advanced port replicator.

● Enable/disable the 1394 port.

● Enable/disable the cardbus slot.

● Enable/disable the ExpressCard slot.

● Enable/disable the infrared port.

● Enable/disable the optical disk drive.

● Enable/disable the network controller.

78 Chapter 5   Computer Setup



6 Specifications

Computer specifications
 Metric U.S.

Dimensions

Length 21.21 cm 8.35 in

Width 29.01 cm 11.42 in

Height (front to rear) 2.82 cm 1.11 in

Weight (equipped with 512-MB memory module, hard
drive, 6-cell battery, WLAN module, and modem
module)

1.63 kg 3.6 lbs

Input power

Operating voltage 19.0 V dc @ 4.74 A – 65 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating (14.7 to 10.1 psia) -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia) -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating 0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate
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Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.

12.1-inch, WXGA display specifications
 Metric U.S.

Dimensions

Height 16.9 cm 6.7 in

Width 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40 horizontal, +120/-40° vertical (typical)
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Hard drive specifications
 100-GB* 80-GB* 60-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Width 70 mm 70 mm 70 mm

Weight 101 g 101 g 101 g

Interface type SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 3 ms 3 ms 3 ms

Average 13 ms 13 ms 13 ms

Maximum 24 ms 24 ms 24 ms

Logical blocks 195,350,400 156,280,320 117,210,240

Disc rotational speed 4200 rpm 4200 rpm 4200 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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System DMA specifications
Hardware DMA System function

DMA0 Not applicable

DMA1* Not applicable

DMA2* Not applicable

DMA3 Not applicable

DMA4 Direct memory access controller

DMA5* Available for PC Card

DMA6 Not assigned

DMA7 Not assigned

*PC Card controller can use DMA 1, 2, or 5.
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System interrupt specifications
Hardware IRQ System function

IRQ0 System timer

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard

IRQ2 Cascaded

IRQ3 Intel 82801DB/DBM USB2 Enhanced Host Controller—24CD

IRQ4 COM1

IRQ5* Conexant AC—Link Audio Intel 82801DB/DBM SMBus Controller—24C3 Data Fax
Modem with SmartCP

IRQ6 Diskette drive

IRQ7* Parallel port

IRQ8 System CMOS/real-time clock

IRQ9* Microsoft ACPI-compliant system

IRQ10* Intel USB UHCI controller—24C2

Intel 82852/82855 GM/GME Graphic Controller

Realtek RTL8139 Family PCI Fast Ethernet Controller

IRQ11 Intel USB EHCI controller—24CD

Intel USB UHCI controller—24C4

Intel USB UHCI controller—24C7

Intel Pro/Wireless 2200BG

TI OHCI 1394 host controller

TI PCI1410 CardBus controller

IRQ12 Synaptics PS/2 TouchPad

IRQ13 Numeric data processor

IRQ14 Primary IDE channel

IRQ15 Secondary IDE channel

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none.

NOTE: PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port
may assert IRQ3 or IRQ4.
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System I/O address specifications
I/O address (hex) System function (shipping configuration)

000 - 00F DMA controller no. 1

010 - 01F Unused

020 - 021 Interrupt controller no. 1

022 - 024 Opti chipset configuration registers

025 - 03F Unused

02E - 02F 87334 “Super I/O” configuration for CPU

040 - 05F Counter/timer registers

044 - 05F Unused

060 Keyboard controller

061 Port B

062 - 063 Unused

064 Keyboard controller

065 - 06F Unused

070 - 071 NMI enable/RTC

072 - 07F Unused

080 - 08F DMA page registers

090 - 091 Unused

092 Port A

093 - 09F Unused

0A0 - 0A1 Interrupt controller no. 2

I/O Address (hex) System function (shipping configuration)

0A2 - 0BF Unused

0C0 - 0DF DMA controller no. 2

0E0 - 0EF Unused

0F0 - 0F1 Coprocessor busy clear/reset

0F2 - 0FF Unused

100 - 16F Unused

170 - 177 Secondary fixed disk controller

178 - 1EF Unused

1F0 - 1F7 Primary fixed disk controller

1F8 - 200 Unused

201 JoyStick (decoded in ESS1688)

202 - 21F Unused
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I/O address (hex) System function (shipping configuration)

220 - 22F Entertainment audio

230 - 26D Unused

26E - 26 Unused

278 - 27F Unused

280 - 2AB Unused

2A0 - 2A7 Unused

2A8 - 2E7 Unused

2E8 - 2EF Reserved serial port

2F0 - 2F7 Unused

2F8 - 2FF Infrared port

300 - 31F Unused

320 - 36F Unused

370 - 377 Secondary diskette drive controller

378 - 37F Parallel port (LPT1/default)

380 - 387 Unused

388 - 38B FM synthesizer—OPL3

38C - 3AF Unused

3B0 - 3BB VGA

3BC - 3BF Reserved (parallel port/no EPP support)

3C0 - 3DF VGA

3E0 - 3E1 PC Card controller in CPU

3E2 - 3E3 Unused

3E8 - 3EF Internal modem

3F0 - 3F7 “A” diskette controller

3F8 - 3FF Serial port (COM1/default)

CF8 - CFB PCI configuration index register (PCIDIVO-1)

CFC - CFF PCI configuration data register (PCIDIVO-1)
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System memory map specifications
Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

48 KB 000C0000-000CBFFF Video BIOS

160 KB 000C8000-000E7FFF Unused

64 KB 000E8000-000FFFFF System BIOS

15 MB 00100000-00FFFFFF Extended memory

58 MB 04800000-07FFFFFF Super extended memory

58 MB 04800000-07FFFFFF Unused

2 MB 08000000-080FFFFF Video memory (direct access)

4 GB 08200000-FFFEFFFF Unused

64 KB FFFF0000-FFFFFFFF System BIOS
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7 Screw listing

This section provides specification and reference information for the screws and screw locks used in
the computer. All screws listed in this section are available in the Screw Kit, spare part number
454687-001.
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Phillips PM2.0×5.0 captive screw

Color Quantity Length Thread Head diameter

Black 6 5.0 mm 2.0 mm 5.0 mm

Where used: 6 captive screws that secure the hard drive compartment cover to the computer (screws
are captured on the cover by C-clips)
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Phillips PM2.0×3.0 screw

Color Quantity Length Thread Head diameter

Black 2 3.0 mm 2.0 mm 4.5 mm

Where used: 2 screws that secure the hard drive bracket to the system board
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Phillips PM2.5×4.0 screw

Color Quantity Length Thread Head diameter

Black 6 4.0 mm 2.5 mm 5.0 mm

Where used:

(1) Two screws that secure the WLAN module to the system board

(2) Two screws that secure the WWAN module to the system board
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Where used: 2 screws that secure the modem module to the system board
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Torx T8M2.0×8.0 screw

Color Quantity Length Thread Head diameter

Black 9 8.0 mm 2.0 mm 5.0 mm

Where used:

(1) Six screws that secure the keyboard to the computer

(2) Three screws that secure the top cover to the base enclosure
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Torx T8M2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.0 mm 5.0 mm

Where used:

(1) Two screws that secure the rear plastic bezel to the base enclosure

(2) Two screws that secure the top cover to the base enclosure
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Phillips PM2.0×5.0 screw

Color Quantity Length Thread Head diameter

Black 5 5.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the top cover to the base enclosure

Where used: One screw that secures the audio connector board to the base enclosure
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Where used: One screw that secures the Bluetooth module to the base enclosure

Where used: One screw that secures the system board to the base enclosure
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Black Phillips PM2.0×6.0 screw

Color Quantity Length Thread Head diameter

Black 1 6.0 mm 2.0 mm 5.0 mm

Where used: One screw that secures the speaker to the base enclosure
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Silver Phillips PM2.0×6.0 screw

Color Quantity Length Thread Head diameter

Silver 2 6.0 mm 2.0 mm 5.0 mm

Where used: 2 screws that secure the display panel cable to the system board
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Phillips PM2.0×4.0 screw

Color Quantity Length Thread Head diameter

Black 1 4.0 mm 2.0 mm 4.5 mm

Where used: One screw that secures the display converter cable to the system board
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Phillips PM2.5×7.0 screw

Color Quantity Length Thread Heat width

Silver 4 7.0 mm 2.5 mm 5.0 mm

Where used: 4 screws that secure the display assembly to the base enclosure
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Phillips PM2.5×7.0 captive screw

Color Quantity Length Thread Head diameter

Silver 6 7.0 mm 2.5mm 5.0 mm

Where used: 6 captive screws that secure the fan/heat sink assembly to the system board (screws are
captured on the fan/heat sink assembly by C-clips)
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8 Backup and recovery

Backup and recovery in Windows Vista
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system
and software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL
(purchased separately). The discs you use will depend on the type of optical drive installed in your
computer. Because DVDs store more information than CDs, DVDs and DVDs with double-layer
(DL) support reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup & Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create a set of recovery discs (Recommended), you will be prompted
to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create a set of recovery discs (Recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.
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With HP Backup & Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events

When to back up

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions

● Create a set of recovery discs using HP Backup & Recovery Manager.

● Create system recovery points using HP Backup & Recovery Manager, and periodically copy them
to disc.

● Store personal files in the Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup & Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

102 Chapter 8   Backup and recovery



To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Back up user created files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Entire Drive Backups, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

2. Click Next.

3. Click Create or manage backups, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup & Recovery Manager to create an entire drive backup as soon as you set up your computer.

HP Backup & Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup & Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup & Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > Backup & Recovery Manager.

3. Click Next.

4. Click Perform a recovery, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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Backup and recovery in Windows XP
Creating recovery discs

After setting up the computer for the first time, be sure to create a set of recovery discs of the full factory
image. The recovery discs are used to start up (boot) the computer and recover the operating system
and software to factory settings in case of system instability or failure.

Note the following guidelines before creating recovery discs:

● Use any of the following types of discs: CD-R, DVD+R, DVD+R DL, DVD-R, or DVD-R DL
(purchased separately). The discs you use will depend on the type of optical drive installed in your
computer. Because DVDs store more information than CDs, DVDs and DVDs with double-layer
(DL) support reduce the number of discs required.

NOTE: Read-write discs, such as CD-RW, DVD+RW, and DVD-RW, are not compatible with the
HP Backup and Recovery Manager software.

● The computer must be connected to AC power during the process.

● Only one set of the recovery discs can be created per computer.

● Number each disc before inserting it into the optical drive of the computer.

● If necessary, you can cancel the disc creation before you have finished creating the recovery discs.
The next time you select Create factory software recovery CDs or DVDs to recover the system
(Highly recommended), you will be prompted to continue the disc creation.

To create a set of recovery discs:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Create factory software recovery CDs or DVDs to recover the system (Highly
recommended), and then click Next.

4. Follow the on-screen instructions.

Backing up your information
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.

With HP Backup and Recovery Manager, you can perform the following tasks:

● Backing up your information regularly to protect your important system files

● Creating system recovery points that allow you to reverse undesireable changes to your computer
by restoring the computer to an earlier state

● Scheduling backups at specific intervals or events
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When to back up

● On a regularly scheduled basis

NOTE: Set reminders to back up your information periodically.

● Before the computer is repaired or restored

● Before you add or modify hardware or software

Backup suggestions

● Create a set of recovery discs using HP Backup and Recovery Manager.

● Create system recovery points using HP Backup and Recovery Manager, and periodically copy
them to disc.

● Store personal files in the My Documents folder and back up these folders periodically.

● Back up templates stored in their associated programs.

● Save customized settings in a window, toolbar, or menu bar by taking a screen shot of your settings.

The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen.

b. Copy the screen.

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, and then select Edit > Paste.

NOTE: Before you can perform backup and recovery procedures, the computer must be connected
to external power.

NOTE: Drivers, utilities, and software installed by HP can be copied to a CD or to a DVD using HP
Backup and Recovery Manager.

Backing up specific files or folders
You can back up specific files or folders to the recovery partition on the hard drive, to an optional external
hard drive, or to optical discs (CDs or DVDs).

NOTE: This process will take several minutes, depending on the file size and the speed of the
computer.

To back up specific files or folders:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.
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4. Click Back up individual files and folders, and then click Next.

5. Follow the on-screen instructions.

Backing up the entire hard drive
When you perform a complete backup of the hard drive, you are saving the full factory image, including
the Windows® operating system, software, and all personal files and folders.

NOTE: A copy of the entire hard drive image can be stored on another hard drive, on a network drive,
or on recovery discs that you create.

NOTE: This process may take over an hour, depending on your computer speed and the amount of
data being stored.

To back up your entire hard drive:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Back up entire hard drive, and then click Next.

5. Follow the on-screen instructions.
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Creating recovery points
When you back up modifications since your last backup, you are creating system recovery points. This
allows you to save a snapshot of your hard drive at a specific point in time. You can then recover back
to that point if you want to reverse subsequent changes made to your system.

NOTE: The first system recovery point, a snapshot of the entire image, is automatically created the
first time you perform a backup. Subsequent recovery points make copies of changes made after that
time.

HP recommends that you create recovery points at the following times:

● Before you add or extensively modify software or hardware

● Periodically, whenever the system is performing optimally

NOTE: Recovering to an earlier recovery point does not affect data files or e-mails created since that
recovery point.

To create a system recovery point:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

2. Click Next.

3. Click Back up to protect system settings and important data files, and then click Next.

4. Click Create or manage Recovery Points, and then click Next.

5. Follow the on-screen instructions.

Scheduling backups
Use HP Backup Scheduler to schedule backups for the entire system, for recovery points, or for specific
files and folders. With this tool, you can schedule backups at specific intervals (daily, weekly, or monthly)
or at specific events, such as at system restart or when you dock to an optional docking station (select
models only).

To schedule backups:

1. Select Start > All Programs > HP Backup & Recovery > HP Backup Scheduler.

2. Follow the on-screen instructions.

Performing a recovery
NOTE: You can only recover files that you have previously backed up. HP recommends that you use
HP Backup and Recovery Manager to create an entire drive backup as soon as you set up your
computer.

HP Backup and Recovery Manager helps you with the following tasks for safeguarding your information
and restoring it in case of a system failure:

● Recovering important files—This feature helps you reinstall important files without performing a full
system recovery.

● Performing a full system recovery—With HP Backup and Recovery Manager, you can recover your
full factory image if you experience system failure or instability. HP Backup and Recovery Manager
works from a dedicated recovery partition on the hard drive or from recovery discs you create.
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Performing a recovery from the recovery discs
To perform a recovery from the recovery discs, follow these steps:

1. Back up all personal files.

2. Insert the first recovery disc into the optical drive and restart the computer.

3. Follow the on-screen instructions.

Performing a recovery from the hard drive
There are 2 ways to initiate a recovery from the hard drive:

● From within Windows

● From the recovery partition
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Initiating a recovery in Windows

To initiate a recovery in Windows, follow these steps:

1. Back up all personal files.

2. Select Start > All Programs > HP Backup & Recovery > HP Backup and Recovery Manager.

3. Click Next.

4. Click Recover important files or the entire system, and then click Next.

5. Follow the on-screen instructions.

Initiating a recovery from the hard drive recovery partition

To initiate a recovery from the hard drive recovery partition, follow these steps:

1. Back up all personal files.

2. Restart the computer, and then press f11 before the Windows operating system loads.

3. Click a recovery option, and then click Next.

4. Follow the on-screen instructions.
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9 Connector pin assignments

Audio-out (headphone)

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground

Audio-in (microphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground
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External monitor

Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused

RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Universal Serial Bus

Pin Signal

1 +5 VDC

2 Data -

3 Data +

4 Ground
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10 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120
volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region  where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard
Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

Korea EK 4

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding
type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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11 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general household
waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

CAUTION: The procedures in this appendix can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the backlight.
Careful handling must be exercised when removing these components. When you remove these
components, handle them carefully.

NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display assembly
that might require special handling at end-of-life. Disposal of mercury may be regulated because of
environmental considerations. For disposal or recycling information, contact your local authorities, or
see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this appendix are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from
one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of the
display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside down.

WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.

20. Remove the screws (2) that secure the LCD panel to the display rear panel.

21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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1394 port 13

A
AC adapter, spare part

number 24,  26
accessory battery connector 15
accessory battery connector

door 15
ambient light sensor 7
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disconnecting 45,  47
spare part number 29

audio connector board
removal 58
spare part number 19,  29,

58
audio, product description 2
audio-in jack

location 13
pin assignments 113

audio-out jack
location 13
pin assignments 113

B
backing up 101,  107
backup

files and folders 102,  108
hard drive 103,  109
modifications made to the

system 104,  110
scheduling 104,  110

base enclosure, spare part
number 19,  30

battery
location 15
removal iii
spare part number 19,  28,

31,  iii

battery bay 15
battery light 8
battery release latch 15
Bluetooth compartment 11
Bluetooth module

removal 59
spare part number 19,  29,

59
Bluetooth module cover,
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boot options 77
boot order 77
bottom components 15
button components 7
buttons

external WWAN antenna 11
info 14
keyboard light 6,  11
left pointing stick 7
presentation 7
right pointing stick 7
rotate 12
volume mute 7
Windows security 12

C
Cable Kit, spare part number 23,

29
cables, service considerations 33
camera light 6,  11
camera mode switch 6,  11
camera, location 6
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chipset, product description 1
CMOS clearing 37
components
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buttons 7
display 6
front 11
keys 10
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switches 7
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computer feet
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spare part number 19,  38
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Diagnostics menu 76
File menu 75
navigating and selecting 74
restoring factory settings 74
Security menu 76
System Configuration

menu 77
using 74

computer specifications 79
connectors

accessory battery 15
docking 15
power 12
service considerations 33
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creating recovery points 104,

110

D
Diagnostics menu 76
Disk Sanitizer 76
diskette drive

precautions 33
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product description 2
spare part number 24

display assembly
removal 62
spare part numbers 17,  29,

62
display component recycling 119
display components 6
display release latch 11
display specifications 80
display switch 7
docking connector 15
docking station, spare part

number 24,  30
docking support, product

description 4
drive light 8
DriveLock password 76
drives

boot order 77
preventing damage 33

DVD-ROM Drive, spare part
number 24

DVD/CD-RW Combo Drive, spare
part number 24

E
electrostatic discharge 34
esc key 10
Ethernet, product description 2
Execution Disable 77
ExpressCard slot 14
ExpressCard slot bezel,

illustrated 24
external media cards, product

description 3
external monitor port

location 12
pin assignments 114

External MultiBay II power cable
and stand, spare part
number 24

External MultiBay II, spare part
number 24

external WWAN antenna
button 11

F
fan/heat sink assembly

removal 65
spare part number 19,  29,

65
feet

locations 38
spare part number 19,  38

File menu 75
fingerprint reader 6
fingerprint reader board, spare part

number 17,  29
fn key 10
foil shield, spare part number 31
front components 11
function keys 10

G
graphics, product description 1
grounding equipment and

methods 36

H
hard drive

location 15
precautions 33
product description 2
removal 41
spare part numbers 22,  29,

31,  41
specifications 81

hard drive backup 103,  109
hard drive bracket, removal 42
hard drive compartment 15
hard drive compartment cover

illustrated 24
removal 41

hard drive recovery 105,  111
hard drive test 76
headphone jack

location 13
pin assignments 113

heat shield, spare part
number 30

heat shield—system board, spare
part number 23

HP 2700 Ultra-Slim Expansion
Base, spare part number 24,
30

I
I/O address specifications 84
info button 14
interrupt specifications 83

J
jacks

audio-in 13
audio-out 13
headphone 13
microphone 13
modem 12
network 12
RJ-11 12
RJ-45 12

K
key components 10
keyboard

product description 4
removal 50
spare part numbers 17,  29,

50
keyboard light 6
keyboard light button 6,  11
keys

esc 10
fn 10
function 10
numeric keypad 10
Windows applications 10
Windows logo 10

L
LAN Power Save 77
language, changing in Computer

Setup 77
latches

battery release 15
display release 11

left pointing stick button 7
left-side components 14
legacy support, Universal Serial

Bus (USB) 73,  77
light components 8
lights

battery 8
camera 6,  11
caps lock 8
drive 8
keyboard 6
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num lock 9
power 8
volume down 8
volume mute 8
volume up 9
wireless 14

M
Media Card Reader 13
memory check 76
memory map specifications 86
memory module

product description 1
removal 49
spare part numbers 22,  29,

49
microphone

location 6
spare part number 17,  29

microphone jack
location 13
pin assignments 113

modem jack
location 12
pin assignments 115

modem module
product description 2
removal 65
spare part numbers 19,  28,

65
monitor port

location 12
pin assignments 114

N
navigating in Computer Setup 74
network jack

location 12
pin assignments 115

num lock light 9
numeric keypad keys 10

O
operating system, product

description 5
optical drive

precautions 33
product description 2

P
packing guidelines 35

panels, product description 1
parallel port mode 77
password clearing 37
passwords 76
pen slot 14
pen, spare part number 24,  29
pin assignments
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audio-out jack 113
external monitor port 114
headphone jack 113
microphone jack 113
modem jack 115
monitor port 114
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RJ-11 115
RJ-45 jack 115
USB port 116

plastic parts 32
Plastics Kit

contents 24
spare part number 18,  24,

29
pointing device components

left pointing stick button 7
pointing stick 7
right pointing stick button 7

pointing devices, product
description 4

pointing stick 7
ports

1394 13
external monitor 12
monitor 12
powered USB 14
product description 3
Universal Serial Bus (USB) 13
USB 14

power connector 12
power cord

set requirements 117
spare part numbers 24,  26

power light 8
power requirements, product

description 4
power switch 11
power-on password 76
powered USB port 14
presentation button 7
processor, product description 1

product description
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chipset 1
diskette drive 2
docking support 4
Ethernet 2
external media cards 3
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hard drives 2
keyboard 4
memory module 1
modem module 2
operating system 5
optical drives 2
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pointing devices 4
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power requirements 4
processors 1
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serviceability 5
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R
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removal 52

recovery discs
creating 101,  107
using 105,  111

recovery partition 106,  112
recovery points 104,  110
removal/replacement

preliminaries 32
procedures 38

restoring Computer Setup factory
settings 74

right pointing stick button 7
right-side components 13
RJ-11 jack

location 12
pin assignments 115

RJ-45 jack
location 12
pin assignments 115

rotate button 12
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RTC battery
removal 37
spare part number 19,  29,

37
Rubber Kit, spare part

number 19,  29

S
scheduling backups 104,  110
Screw Kit

contents 87
spare part number 25,  29

screw listing 87
security cable slot 13
Security menu 76
security, product description 4
selecting in Computer Setup 74
serial number 16,  38
service considerations 32
serviceability, product

description 5
shield, metal, wireless
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spare part numbers 31

SIM slot 15
SIM, removal 40
smart card reader 14
smart card reader module, spare

part number 23,  29
smart card security 76
solid-state drive

spare part numbers 31
speaker
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spare part number 19,  29,
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specifications

computer 79
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hard drive 81
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interrupts 83
memory map 86
system DMA 82

startup check 76
static-shielding materials 36
stringent security 76
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camera mode 6,  11

power 11
wireless 14

system backup 103,  109
system board

removal 65
spare part numbers 19,  31,

65
system board heat shield, spare

part number 30
System Configuration menu 77
system DMA 82
system fan 77
system information 75
system memory map 86
system recovery points 104,  110

T
thermal material, replacement 69
tools required 32
top components 6
top cover

removal 54
spare part number 19,  29,

54
transporting guidelines 35

U
Universal Serial Bus (USB) legacy

support 77
unknown password 37
USB legacy support 73
USB port

location 13
pin assignments 116

V
vents 14,  15
volume down light 8
volume mute button 7
volume mute light 8
volume scroll zone 7
volume up light 9

W
Windows applications key 10
Windows logo key 10
Windows security button 12
wireless antenna

disconnecting 45,  47
wireless light 14
wireless switch 14

wireless, product description 2
WLAN module

removal 43
spare part numbers 19,  26,

43
workstation guidelines 35
WWAN antenna

location 11
spare part number 17,  29

WWAN module
removal 47
spare part numbers 22,  28,

30,  31,  47
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